How to use ICC12 with Adapt9S12XDP512 and BDM Pod

This document will show and demonstrate the use of ImageCraft ICC12 Version
6 with the Technological Arts Adapt9S12XDP512 module.

The XGATE BDM pod (MicroBDM12XG) will be used here to erase and program
Flash after the compilation of a test program. While there are other methods to
erase and program the Flash, this example will use the XGATE BDM pod.

This document assumes that the user is familiar with C and so will not teach how
to program C here.
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Getting Started:
Double click on the ICC12 icon to launch the IDE.

Note the three window panes. The top right pane is the project window. The
lower left ane is where the status and error messages are displayed during
compilation.

Before creating a new Project, the hardware target in the Compiler Options must
be setup properly for the target MCU. In this example it is Adapt9S12XDP512.
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Compiler Setup:

Click on Project Menu — Options — Target Tab.
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Please note the Device Configuration. Click on the pull down arrow to change
the device type.
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Scroll up or down to select Custom as shown.
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Device Configuration:
Custom

Memory Addresses:

Program Memory = 0x4000.0x7FFF:0xC000.0xFFFF
Data Memory = 0x7000

Stack Pointer = 0x4000

Expanded Memory:
Enable Addr = 0x380000.0x3F3FFF.
Make Paged Function Default

Note the address range is 0x380000.0x3F3FFF. |t defines the available PPAGE
to be from $EO to $FC. PPAGE $FD and $FF are fixed memory areas and are
allocated to 0x4000.0x7FFF:0xC000.0xFFFF while PPAGE = $FE is not defined
here. Version 7 of the compiler will properly accommodate the XGATE memory
map when it is released.
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CPU/Banked Address



On the Compiler tab there are several choices of S-record output as shown
Select the one that suits you.
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Starting a new Project:

Once the compiler options are setup, a new project can be created. Click Project
menu — New.

*  ImageCraft IDE for ICC12 (PROFESSTONAL)
File Edit Search View | Project RCS  Tools  Terminal Help

=t P [T

i o= : i =
w Oper... Chrl+F11 & —
pen Al Files iect | Browser |
Close Al Files TEC WO PROJECT OFEN
Reopen... e
IMake Project Fa
Febuild) &l StirtFe
Edd File(s)... ShirtHEL

Add Tepmost Opened File
Hemove Selected Filelsy

Optians...
Manual Sork Brovser Window

Close
SEYE A5,

[I'No Ooen Fils 1 [I'No Open Proiect 1 [513



The IDE will prompt to save the new project. You may decide to create a new
directory to save the new project. In this example a new directory called Test is
created and the file is saved as file test.prj.
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Type the filename as test.prj and click on the Save button
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Note that the Project window has changed to add Files, Headers and
Documents.

ImageCraft IDE for ICC12 (PROFESSIONAL)

3 Files
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w2y Documents

Creating a new file to the project:

To add files to the project, click on the File menu — new as shown.
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Note that ICC12 created an untitled file
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Save the file as BlinkLED.C.
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ICC12 will open an explorer window to help save the file. Type BlinkLED.c for

the filename and then click the save button.
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Note that ICC12 has renamed the file to BlinkLED.c.
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To add BlinkLED.c to the Project, click on the Project menu — Add File(s)
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ICC12 will open an explorer window to help locate the file of interest.
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Note that the right window pane has changed to include BlinkLED.c under the
Files Project.
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Locate vectors.c and copy it to the Test directory. This is important to do
because of project dependency. It is not a good idea to keep editing a single
global vectors.c file for each new project since other projects are using this file.
It becomes a problem to keep track of the changes made to the different projects.

To add vectors.c to the Project, click on the Project menu — Add File(s)
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Note that ICC12 has changed to include vectors.c It is important to note that the
original vectors.c supplied by ImageCraft was written for the 68HC912B32 and
68HC812A4 MCUs. Therefore, it needs to be edited to include other ISR
addresses for the 9S12XDP512.

R
Fle Edt Search View Project RCS Tooks Terminal Hep
NEWd2e688035E
veclons.c | Piject | Eruwserl
!/* To use, either add this file to the project file list (preferred), or & EE TEST
t #include it in & single aource file if you are just using B@ Fies
* File->CompileToOutypus [this vorks but using the Project feature is better  ecse
# : Q BlinkLED ¢
-1 Headss
: : ‘ . ﬁ Documents
[t i3 iz, all interrupts except teset jumps to Oxffff, which is most
* likely not going to useful. To replace an entry, declare your function,
*and then change the corresponding entry in the tahle. For example,
*1f you have a 3CT handler (which must be defined with
T fpragua interrupt handler ...} then in this file:
*add
toextern vold SCIHandler();
* hefore th table.
* In the 3CI entry, change: I
f DUNHY ENTRY,
T to
* 5CIHandler,
tf
#if defined| HC1Z)
[* add any interruot vectors in here too for HC12 paged compilation
tf
#pracs nonpaged function start
fendiz
extern void start(veid); /* entry point in crt??.s #/
#define DUNNY ENTRY (void (*) (void))OxFFFF
#pracs ahs_atdress:Oxffdl
/* change the above address if vour vector atarts elsswhers j
11 Cestechors Cestfesto 1519 4
— — — ; = ——— —



Type the lines of code below into BlinkLED.c file. Once that is done, we can

compile/make/build the code.
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#include "mc9s12dp512.h"

void blink delay(wvoid) ;
void main ()

{

int i;

DDRP = OxFF;
PTP = OxFF;

blink delay();

while (1)

PTP = OxFF;
blink delay();
PTP = 0x00;
blink delay();

void blink delay(void)
{
int 1i;
for (i=0;1<64000; i++)
{

Compiling/Build/Make the file:

To make the file click Project menu — make project as shown.

//LED on

//LED off

= ' ImageCraft IDE for ICC12 (PROFESSIONAL)

File Edit Search View | Project RCS Tools Terminal Help

= T

i

. 3 ey
0o = B e | -
7' open... CrrlHFLL I
BlinkLED ¢ | vectars.c | Spen Al Files
¢ | closeAllFies
ER LSS E Reopen... >
DDRP = =
PTP = ( Rebuild All shift+Fa
1ink Add File(s)... Shift-+F11
IRE_C add Toprost Opened Fils
Remove Selected File(s)
while |
¢ options. ..
Manual Sort Browser Wwindow
FPTF = [
blink ¢ E==
— Save As...
FTF =

Blink delayil:

b

roid blink delayi{void)
d
int i:
£for (i=0;i<62000; i++)
1

i

|4l

Preject | Browser |

= IEE TEST
=& Files
[ vectorse
<Zp BlinkLED
L2y Headers
£ Documents

C:\testsBlinkLED.c

[C:\testhtest ori




Note the lower window pane will show messages to display how the build
progressed. Any errors will be displayed in this window. The build was without

error so we can progress to erasing and programming the 9S12XDP512.
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Locate the c:\Test directory. Note the other extraneous files are created after a

make.
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Using WordPad to check the content of test.s19 file. Note that the S-records are
of different lengths.

S10E4000CF400016405587CE10008E04
S$110400B100027056A000820F6CE405ACDAB
S111401810008E405A2706180A307020F 51644
S1074026402A20FEOA
S111FFDOFFFFFFFFFFFFFFFFFFFFFFFFFFFF2D
S111FFDEFFFFFFFFFFFFFFFFFFFFFFFFFFFF1F
S111FFECFFFFFFFFFFFFFFFFFFFFFFFFFFFF11
S109FFFAFFFFFFFF4000C1
S110402A34B7751B9EC6FF7B025AC6FF7B90
S$110403702584A8000E02010C6FF7B0258AA
S10D40444A8000E07902584A800027
S10A404EE020EEB757303DFE
S2121E0800034B7751B9ECC00006C1E2007EC1EED
S2121E0800EC300016C1EEC1E8CFA0025F2B7577C
S2061E0801C300A43

S$10840551D0016073DEB

S$9034000BC

Examining S-record:

If one looks closely at the S-record one can see a mixture of S1 and S2 lines.
This is a typical S-record file generated by ICC12. S1 records are programmed
in the $4000 - $7FFF and $C000 - $FFFF memory blocks. Any ISR routines are
always in the fixed memory area. The ISR can call any routine inside a PPAGE
when necessary. The S2 records can also be in fixed memory but are typically
placed in paged memory by ICC12

Note the content of the memory address at $FFFE:$FFFF is $4000, the RESET
vector.

S111FFDOFFFFFFFFFFFFFFFFFFFFFFFFFFFF2D
S111FFDEFFFFFFFFFFFFFFFFFFFFFFFFFFFF1F
S111FFECFFFFFFFFFFFFFFFFFFFFFFFFFFFF11
S109FFFAFFFFFFFF4000C1

The S-record below is the start of code. The content of address beginning at
$4000 to $4050

S10E4000CF400016405587CE10008E04
S110400B100027056A000820F6CE405ACDAB
S111401810008E405A2706180A307020F51644
S1074026402A20FEOA



Please note the PPAGE = EO the first available PPAGE as defined by address
range 0x380000.0x3F3FFF.

S2121E0800034B7751BOECC00006C1E2007EC1EED
S2121E0800EC300016C1EEC1E8CFA0025F2B7577C
S2061E0801C300A43

Using P&E LogPhy program:

The LogPhy is used to reformat the ICC12 generated S-record.

Download the LogPhy program from the P&E website and install it on the PC.
While the utility is free, you’ll need to register to download program

http://www.pemicro.com/
http://www.pemicro.com/support/download processor.cim?family=4

Run LogPhy as shown.
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Selecting Device:

Click on the Device Type dropdown list and select 9S12XDP512 as shown.
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Logical Record File:

Click on the Logical Record File to help locate the ICC12 generated test.s19 s-
record.

2l x|
Lok i IE} test LI - i FEEE
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Click the open button. Note the formatted file will be called test.phy.
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Converting:

Press the Convert to S-Record.
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Note the various messages generated by LogPhy. Open the test.prj to examine
the resulting file.

S2147F4000CF400016405587CE10008E100027056AD9
S2147F4010000820F6CE405ACD10008E405A2706184C
S20E7F40200A307020F516402A20FEBS
S2147FFFDOFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFAD
S2147FFFEOFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFOD
S2147FFFFOFFFFFFFFFFFFFFFFFFFFFFFFFFFF40004B
S2147F402A34B7751BOEC6FF7B025AC6FF7B02584A69
S2147F403A8000E02010C6FF7B02584A8000E07902A3
S20F7F404A584A8000E020EEB757303D5C
S21478000034B7751BOECC00006C1E2007EC1EC30010
S212780010016C1EEC1E8CFA0025F2B757300AEB
S2097F40551D0016073D6B

Note the bold s-record.

S2 - S-record type

09 — Byte count

7F - PPAGE

4055 — Address of DATA to be written to FLASH
1D0016073D - DATA

6B - CRC

The address 4055 is a misaligned word address. The DATA needs to be started
at an even address for use by the Flash programming routine of the BDM pod, so
it will need to be manually corrected.

Open the Original S-record test.s19 to fix this problem

S10E4000CF400016405587CE10008E04
S110400B100027056A000820F6CE405ACDAB
S111401810008E405A2706180A307020F51644
S1074026402A20FEOA
S111FFDOFFFFFFFFFFFFFFFFFFFFFFFFFFFF2D
S111FFDEFFFFFFFFFFFFFFFFFFFFFFFFFFFF1F
S111FFECFFFFFFFFFFFFFFFFFFFFFFFFFFFF11
S109FFFAFFFFFFFF4000C1
S110402A34B7751B9EC6FF7B025AC6FF7B90
S110403702584A8000E02010C6FF7B0258AA
S10D40444A8000E07902584A800027
S10A404EE020EEB757303DFE
S212E0800034B7751BO9ECC00006C1E2007EC1EED
S212E0800EC300016C1EEC1E8CFA0025F2B7577C
S206E0801C300A43

S$10840551D0016073DEB



Move the Bold S-record around to create contiguous S-record addresses.

S10E4000CF400016405587CE10008E04
S110400B100027056A000820F6CE405ACDAB
S111401810008E405A2706180A307020F51644
S1074026402A20FEOA
S110402A34B7751B9EC6FF7B025AC6FF7B90
S110403702584A8000E02010C6FF7B0258AA
S10D40444A8000E07902584A800027
S10A404EE020EEB757303DFE
S10840551D0016073DEB
S111FFDOFFFFFFFFFFFFFFFFFFFFFFFFFFFF2D
S111FFDEFFFFFFFFFFFFFFFFFFFFFFFFFFFF1F
S111FFECFFFFFFFFFFFFFFFFFFFFFFFFFFFF11
S109FFFAFFFFFFFF4000C1
S212E0800034B7751B9ECCO0006C1E2007EC1EED
S212E0800EC300016C1EECT1E8CFAQ0025F2B7577C
S206E0801C300A43

Save the edited file then run LogPhy once more. Below is the newly formatted
test.phy file. Note that it no longer has the misaligned address problem.

S2147F4000CF400016405587CE10008E100027056AD9
S2147F4010000820F6CE405ACD10008E405A2706184C
S2147F40200A307020F516402A20FE34B7751B9EC6D0
S2147F4030FF7B025AC6FF7B02584A8000E02010C6EC
S2147F4040FF7B02584A8000E07902584A8000E020D1
S20E7F4050EEB757303D1D0016073D02
S2147FFFDOFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFAD
S2147FFFEOFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFOD
S2147FFFFOFFFFFFFFFFFFFFFFFFFFFFFFFFFF40004B
S21478000034B7751BO9ECC00006C1E2007EC1EC30010
S212780010016C1EEC1E8CFA0025F2B757300AEB



Programming the Adapt9S12XDP512:

Connect the BDM pod to the target and open a terminal program. In this
example the terminal program is Tera Term.

»|5| 10| x|

File Edit Setup Control Window Help

D-Bugl? 4.5.Hal@ ﬂ
GCopyright 1996 - 2884 Motorola Semiconductor
For Commands type "Help"

Srdevice

Device: S12RDP512, MC95124DP5S12

EEPROM: 5A@A@ — S@FFF

Flash: 58608 — 5BFFF Pages: 32 PPAGE at: $PA38
RaM: %1888 - %3FFF

[/0 Regs: $80B@ - SBVFF

Target Speed: 16888 KH=z

Y|

Erasing:

To erase type fbulk followed by Enter, as shown.

I Tera Term - COM1 ¥T »|5] =[O x]

File Edit Setup Conbrol Window Help

—-Bugl2 4.5.0a1A@ j
opyright 1996 — 2884 Motorola Semiconductor
or Commands type “Help"

ydevice

evice: S12XDP512. MC9512XDPS12

EPROM: $PAAA — SAFFF

lash: 58@@@ - $BFFF Pages: 32 FPPAGE at: 5AA3A
AM: $18B@ — $3FFF
10 Regs: $8880 - 5S@7FF

arget Speed: 16888 KH=z

>£bulk
b




Programming:

To program, type fload followed by Enter, as shown.

I Tera Term - COM1 ¥T 03 =3 ] =4

File Edit Setup Control Window Help

—Bugl12 4.5.@al1@ j
opyright 1976 — 28004 Motorola Semiconductor

or Commands type "Help"

>device

evice: S12XDP512,. MC?512HDPL12

EPROM: 58888 — $@FFF

lash: 58888 - $BFFF Pages: 32 PPAGE at: 50038
AM: 51888 - $3FFF
170 Regs: 0088 — SA7FF

arget Speed: 16880 KH=

*hulk
>fload

Then locate the file test.phy to be sent to the target.

I Tera Term - COM1 ¥T »|5] =[] x|

lﬁ Edt Zetup Confrol Window Help

Mew conmection.,,  AlEHH ﬂ
Log... Motorola Semiconductor
. - pll
Send file, ., I
Transfer b
Change directary. ., &1 2%DP51?
Print.. Mt+P |Pages: 32 PPAGE at: 50838
Disconnect 'F
Exit f+g P2
Hhulk
Hload




An explorer window will pop up to help, as shown.

Tera Term: Send file d |

Look in: I 1) test j &= £ B~

2] BlinkLED . @ Copy of test,s19 kest.prj vectors,dp2
BlinkLED.dp2 kst Ik @ kest,s19 vect-:nrs.i
HlE:] BlinkLED. i kest.Ist kest.s19,extra ] vectors.lis

] BlinkLED.lis test.mak TEST.5RC wectars.o
= BlinkLED. 0 kest.mp weckars, _C weckors. s

'-.fectcurs.c

File name: ItESt.ph_'..' Open

Filez of type: I all j Cancel

Help

P,

Cption
’V [ Binamw

Click Open to initiate the file transfer.

[0 Tera Term - COM1 ¥T

Fie Edit Sefup Control ‘Window Help

D-Bugl? 4.5.@al@
Copyright 1996 - 2084 Motorola Semiconductor

For Commands type “Help"

S rdevice

Device: S124DP512, MC?85123DP512

EEPROM: $60@@ - $S@FFF

Flash: 8808 - SBFFF Pages: 32 PPAGE at: 50@38
RAM: $1808 - $3FFF

1/0 Regs: 5008 - $S@7FF

Target Speed: 16808 KHz

S hulk
G+ load




Reset BDM pod:

Note that the BDM pod seems to “hang” and is unresponsive. Press the BDM
pod reset button to recover. The reason this happens is due to LogPhy not

including an S9 termination S-record.

FI|E Edit Setup Control  window  Help

»15{ (0] x|

D—Bugl2 4.5%.8al8
Copuyright 1996 — 2884 Muturula Semiconductor
For Commands type "“"Help'

B >device

Device: S512XDP512, MC?812HKDFPS512

EEPROM: 58088 — S$BOFFF

Flash: $8AAA — $BFFF Pages: 32 PPAGE at: 588328
RAM:= 510608 — 53FFF

10 Regs: $800A — 507FF

Target Speed: 16088 KH=z=

5 >Fhulk

5>f load

-mE-eE-JeE~eE-Jef oo JoE- -

D—Bugl2 4.5.0a18

Copyright 1996 — 2884 Motorola Semiconductor
For Commands type “"Help"

Can’'t Communicate With Target CFU

H.> Set Target Speed {16880 KH=z>
.» Reset Target

.2 Reattempt Communication

.» Eraze & Unszecure

.» Enter BDHM debugger

RS Ll Y ]

'

-

Checking:

Use the BDM pod to check the vector address in Flash.

FI|E Edit Setup Conktral  Window Help

22 =100 x|

For Commands type "“"Help'
S >device

Device: 512XDP512,. MC?512HDPS512
EEPROM: $PA8AA — 5$BAFFF

Flash: 58888 — $BFFF Pages:- 32 PPAGE at: 568838
RAM: 51888 — 53FFF

1.0 Regs: 58808 — 507FF

Target Speed: 168808 KH=

% >Fhulk

5 >f load

aEaialadalatakaiakakad

D—Bugl2 4.5.0al18

Copyright 19926 — 2884 Motorola Semiconductor
For Commands type "“"Help'

Can’'t Communicate With Target CPU

1.> et Target Speed <16888 KH=z>
2 .2>» Reset Target

3.>» Reattempt Communication

“1.> Erase & Unsecure

E.) Enter BDM debugger

Symd FFEF

=>0

IFFFA@ FF FF FF FF — FF FF FF FF — FF FF FF FF - FF FF 44 08

[




Check start of Program:

Use the BDM pod to check address $4000, as shown.

File Edt Setup Control ‘Window Help

o2 (0] x|

RAM:

Device: S12XDPLH12, MCPS512XDP512
EEPROM: $9088 — SOFFF
Flash: $8888 — $BFFF Pages: 32 PPAGE at: 58030

$1888 — 53FFF

1.0 Regs: $B00@ — S@7FF
Target Speed: 168008 KHs

S >fbhulk

% >f load

EataZatatakstatetatatad

D—Bugl? 4.5_0al18

Copyright 1996 — 2084 Motorola Semiconductor
For Commands type “"Help"

Can't Communicate With Target CPU

1.» Set Target Speed (16888 KH=>
2.2 Reset Target

3.> Reattempt Communication

4. Eraze & Unsecure

E.) Enter BDM debugger

fEff

FF FF FF FF — FF FF FF FF — FF FF FF FF - FF FF 48 88
484

CF 48 B8 16 — 48 55 87 CE — 18 88 SE 18 - 68 27 85 6A

Press the Adapt9S12XDP512 RESET button.

Once the RESET button is pressed, the Red LED will begin to blink. This
concludes how to use ICC12 with Adapt9S12XDP512 and MicroBDMXG BDM

pod.




